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SAFETY PRECAUTIONS 
This manual describes the precautions using various pictorial symbols for you to use the product 
safely. Please read these precautions thoroughly before use. The symbols and meanings are as 
follows: 
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HOW TO READ THE OPERATION MANUAL 
This section explains general notes on reading the VMP Operation Manual, and the 
symbols and notations used in this manual. 
 

■Notes on the Guide 
 This guide is written for readers with a basic knowledge of Windows. 
 The contents of this guide are subject to change without notice in the future. 
 

■Symbols 
The symbols used in this manual are as follows. 
 

CAUTION: Things you have to be careful during operation. Please be sure to read. 

Note: Supplementary notes and reference information. 

Reference: Sections where related information is available. 

 
■Illustrations and displays 

The illustration and displays in the text are provided for explanation and may be slightly 
different from the actual equipment or image. 
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 Overview 
Virtual Master Panel (hereinafter VMP) is an application software that runs on a 
Windows® PC and provides integrated management functions for broadcast 
cameras over an IP network. It realizes camera maintenance as an MCP and 
centralized management by taking advantage of IP network camera control. 
 
CAUTION: 
 Need to log in to Windows® with administrator authority when installing VMP. 
 Some images of application in this document may differ from actual. 
 

1.1. Features 
 

 Camera Control and Maintenance 
VMP has camera control and maintenance functions similar to an MCP. 
 

 File Management 
User can manage camera files on the PC. 
 

 Camera Information Monitoring 
Lists and monitors Camera Status, Diagnostics, and Optical Level 
information. 
 

 User Customize 
On the HOME launcher displayed at startup and the USER screen of Control 
category, users can select the functions. 
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1.2. System Structure 
The standard network configuration is as follows. 
 

 
Figure. 1.2-1 

 
By configuring the Default Gateway properly on each device, you can also 
configure the network with multiple Broadcast Domains. 
 
In order for VMP to identify each device, it is necessary to set the following 
items in addition to the IP address. 
 Group ID 
 Device ID 
 ICNP Master 
 
Please set the IP address of the PC on which VMP is installed as MASTER's 
address. It can be either Primary or Secondary. 
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1.3. Software Structure 
VMP consists of two software programs: a GUI application as a user interface 
and a communication application that runs in the background. 
 
A GUI application does not communicate with camera devices directly. The 
communication application does it. 
 

 
Figure. 1.3-1 

 
When changing the network setting of the PC, the same settings as those at 
the time of installation are required. 
 
Note: 
Because the communication application is registered in the startup at the time 
of installation, it is not necessary to be conscious of it in normal use. 

 

1.4. How to start 
VMP can be started in the following two ways. 
 
(1) Start menu 

Open the start menu and execute the following link. 
[All Programs > Ikegami > Virtual Master Panel > VirtualMasterPanel] 

 
(2) Desktop shortcut 

Execute desktop shortcut. 
 
CAUTION: 
More than one VMP can not be started simultaneously 

 

1.5. How to quit 
VMP can be terminated in the following two ways. 
 
(1) From Menu bar 

From Menu bar File > Quit. 
 
(2) Force quit 

Press Alt + F4 keys. (Views no confirmation dialog) 
 

VMP

GUI

Communication

USER

CAMERA
DEVICES
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 User Interface 
The names and functions of each part of the application are explained below. 

 

 
Figure. 2-1 

 
VMP is mainly composed of the following six areas. Some areas are not displayed 
depending on the selected function category. 

Table. 2-1 

1 Menu bar 
2 Toolbar 
3 Group Select Area 
4 Multi Select Area 
5 Camera Select Area 
6 Main Area 
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2.1. Menu bar 
The following functions can be used from the Menu bar. 
 

 
Figure. 2.1-1 

Table. 2.1-1 

File Import License... Open file dialog for import license. 
Quit Quit application 

Setting Scaling Change Scaling percentage 
Control Depth Change Control Depth level. 
Configurations... Open configuration dialog. 

Help Manual Open Operation Manual. (this document) 
License View license status and expiration date. 
About View version information. 

 
 

2.2. Toolbar 
Buttons of the function category are arranged in the Toolbar. When a category 
button is pressed, the application category switches and main area display also 
changes. Other than the TOOL category, the Group Select Area, the Multi Select 
Area, and the Camera Select Area are always displayed. 
 

 
Figure. 2.2-1 

Table. 2.2-1 

HOME 
 

Switch to the HOME launcher. Immediately after startup, the HOME 
launcher  is displayed and it can be customized at Configurations. 
See Section 8.1 for details. 

CONTROL Switch the category to CONTROL. You can adjust the camera image with 
MCP-like interface. 
See Section 4.2 for details. 

SETUP Switch the category to SETUP. You can run auto setup and manage 
camera setup files. 
See Section 4.3 for details. 

MONITOR Switch the category to MONITOR. Displays the status of the cameras of 
the selected group in a list. 
See Section 5 for details. 

TOOL Switch the category to TOOL. Panel assignment can be displayed / 
changed. 
See Section 6 for details. 

 
  



Group Select Area 

6 

An indicator showing the connection status with the communication application 
is displayed at the right end of the Toolbar. 
 

 
Figure. 2.2-2 

 
 

2.3. Group Select Area 
Switch the group of cameras to be operated. 
The cameras to be assigned to each group is set from Configurations. 
 

 
Figure. 2.3-1 

 
 

2.4. Multi Select Area 
Switch to the multi control mode and select the cameras to be controlled in 
parallel. 
See Section 3.2 for details. 
 

 
Figure. 2.4-1 

 
 

2.5. Camera Select Area 
Select the camera to be operated. 
Various indicators and CALL buttons are arranged for each camera. 
If the assigned camera is not connected, the button will not operate. 
 

 
Figure. 2.5-1 
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2.6. Main Area 
In the Main Area, the contents corresponding to the selected function category 
are displayed. 
 

2.6.1. Home 
Home is not a function category, it functions as a launcher for direct access to 
each page. 
Immediately after startup, Home is displayed. You can also make transition 
from Toolbar's Home button. 
The items on the Home launcher can be arbitrarily assigned by the user from 
the Control, the Setup, and the Monitor categories. 
See Section 8.1 for details. 
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2.6.2. Control 
Control is a function category that selects and controls the target camera as 
an MCP. 
It is mainly aimed at image adjustment during camera maintenance. 
As a basic screen configuration, page selection buttons on the left, control 
items in the center, and common control items on the right side are arranged. 
 

 
Figure. 2.6.2-1 

The pages of Control category are as follows. 

Table. 2.6.2-1 

ON/OFF - 
VIDEO VIDEO 1 

VIDEO 2 
SML VIDEO 

DTL DTL 
SML DTL 

COLOR COLOR 
CSTM COLOR 
COLOR CORR. 6 
COLOR CORR. 16 
SML COLOR 
SML CSTM COLOR 
SML COLOR CORR. 16 

ETC. SYSTEM 
LENS 
TRIAX 
OTHERS 

USER USER1 
USER2 
USER3 
USER4 
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2.6.3. Setup 
Setup is a function category that summarizes functions such as auto setup 
and file management. 
As a basic screen configuration, page selection buttons on the left, control 
items in the center, and common control items on the right side are arranged 
like Control. 
 

 
Figure. 2.6.3-1 

 
The pages of Setup category are as follows. 

Table. 2.6.3-1 

STANDARD - 
FILE TRANSFER 

MANAGEMENT 
AUTO SETUP AUTO 

REFERENCE 
FORMAT - 

 

2.6.4. Monitor 
Monitor is a function category that lists the status of the cameras in the 
selected group. 
 

 
Figure. 2.6.4-1 

The pages of Monitor category are as follows. 

Table. 2.6.4-1 

DEVICE - 
CAMERA STATUS - 
DIAGNOSTIC - 
OPTICAL LEVEL - 
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2.6.5. Tool 
Tool is an independent function category that does not assume group and 
camera select. Only the panel assignment function can be used. 
The Group Select Area, the Multi Select Area, and the Camera Select Area are 
not displayed. 
 
 

 
Figure. 2.6.5-1 
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 Selecting Groups and Cameras  

3.1. Basic concept 
Basically, for each category of Control and Setup, select the target camera with 
Group Select and Camera Select. 
VMP can control up to 100 cameras, and camera assign numbers and group 
assignments are set in Configurations. 
From 1 to 16 cameras can be arbitrarily assigned to each group. 
It is also possible to duplicate assignments between groups. 

 

Table. 3.1-1 

Group Number Range of Camera Select Number 
1 1~10 
2 11~20 
3 21~30 
4 31~40 
5 41~50 
6 51~60 
7 61~70 
8 71~80 
9 81~90 
10 91~100 
11 No Assignment 
12 No Assignment 

 
Note: 
Unlike our MCP, VMP only switches control targets. There is no Preview 
command to link VMP with a router or other external equipment. 
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3.2. Multi control 
Multiple control of VMP allows simultaneous control to multiple cameras within 
the same group. (There are some functional restrictions.) 
 
The multi-control enabled state is referred to as multi-mode, and the single 
control state is referred to as single mode, and the mode is switched by the 
multi mode switching button in the Multi Select Area. 
 
In multi mode, the parallel selection button becomes effective, and you can add 
and delete cameras to be controlled at the same time. 
The camera selected by camera select in multi mode is called master, and the 
other camera to be controlled is called slaves. 
The status of the master is displayed on the control screen. 
When changing the master camera, you can select only from the parallel 
selected cameras. 
 
The master and parallel selection state for each group in multi mode is 
memorized even after switching to single mode only during starting. 
You can switch whether or not the state will be reproduced when switching to 
multi mode again. (See Section 9 for details.) 
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 Controlling Cameras 
VMP can perform camera control and maintenance as an MCP. 
 
CAUTION: 
The functions described in this manual may be inoperative depending on the 
camera head and CCU to be used, and the license status. 
If the function can not be used, check the corresponding function and license of 
the camera head and CCU. 

 

4.1. Common 
 

4.1.1. On/Off Control 
There are three types of camera On/Off control. That are alternate type, 
momentary type, and select type. 
 
 Alternate type 

An alternate type is switched between On and Off each time the button is 
pressed. There are two of alternate types. 

 
 Off On 

Normal type 

  
Reverse type 
(written with OFF) 

  

 
 Momentary type 

A momentary type is switched On while pressing the button. This type is 
CALL button only. 

 
 Off On 

CALL button 
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 Select type 
In the case of the select type, pressing the button opens the list of choices. 
If there are many choices, a scroll bar will be displayed.  
Select the item or press it again to close the list. 

 
 Close Open 

Select type 

  
 

CAUTION: 
All defined items are displayed in the list of select type. If it does not 
change to that value even if you select it, please check whether the 
camera supports that function. 

 
  



Analog Control 

15 

4.1.2. Analog Control 
There are two types of camera analog control. One is the slider type and the 
other is rotate type. Type and control range can be set in Configurations. 
 
 Slider type 
 

 
 
 

1 Center button (slider moves only) 
2 Slider control 
3 Fine adjustment 
4 Manual Set button 
5 Manual Clear button 

 
 Rotate type 

 

 
 
 

1 Rotate control 
2 Manual Set button 
3 Manual Clear button 

 
 
  

１ 2

3 4 5

１

2 3
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4.1.3. Common Control 
The common controls are displayed at all times when the Control category or 
Setup category is selected. It provides basic camera control functions. 
 

 
Figure. 4.1.3-1 

 

Table. 4.1.3-1 

1 OFFSET button 
2 On/Off control, Analog control 
3 IRIS control 
4 Scene file Load/Store 

 
 
  

１

2 3

4
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4.1.4. On-Air Tally guard 
The On-Air Tally guard is a function to prohibits some controls during On-Air 
Tally. 
 

Table. 4.1.4-1 

Function Item 
Setting of Configurations 

Off Limit All 
CAM PWR  ✔ ✔ 
VF PWR  ✔ ✔ 
CAP  ✔ ✔ 
BARS  ✔ ✔ 
CAL  ✔ ✔ 
AUTO IRIS    
GAIN WOBBLE ✔ ✔ ✔ 
ZEBRA INDICATOR ✔ ✔ ✔ 
HEAD BARS ✔ ✔ ✔ 
CUSTOM GAMMA DEFAULT CLEAR ✔ ✔ ✔ 
WFM SELECT    
PM SELECT    
(On/Off items other than above)   ✔ 
AWB/ABB  ✔ ✔ 
SYSTEM FORMAT   ✔ 
SCEN FILE LOAD   ✔ 
HD CUTOUT   ✔ 
AUTO SETUP (other than AWB/ABB)   ✔ 
PRESET FILE LOAD  ✔ ✔ 
MANUAL SET/CLEAR   ✔ 
ALL MANUAL SET/CLEAR  ✔ ✔ 
FILE TRANSFER SEND ✔ ✔ ✔ 

✔ = Applies tally guard 
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4.2. Control category 
In Control Category, each control is arranged on the page with a concept similar 
to an MCP. 

 

4.2.1. ON/OFF 
In the ON/OFF page, the common On/Off controls are consolidated on one 
page. The arranged controls are as follows. 

Table. 4.2.1-1 

Page Control 

ON/OFF GAMMA OFF W.CLIP OFF 
BLACK GAMMA FLARE OFF 
KNEE OFF B.SHADE OFF 
AUTO KNEE W.SHADE OFF 

GAMMA MODE DTL OFF 
STEP GAMMA  
SMOOTH KNEE  
SUPER KNEE  

 SOFT DTL 
 SKIN DTL 
 SLIM DTL 
 SML DIAGONAL DTL 

BLK STR/PRS Z.TRACK DTL 
SUPER V Z.TRACK SKIN 
SHUTTER MODE COLOR DTL 
SHUTTER SPEED HI-LIGHT DTL 

MATRIX OFF COLOR SAT. 
COLOR HUE CHROMA OFF 
 COLOR CORR. 
 C.TEMP 5600K 

MATRIX SELECT CSTM COLOR 1 
 CSTM COLOR 2 
 ATW 
 VAR C.TEMP 

FILTER HEAD  
FILTER HOLD  
AVC  

ND FILTER  
CC FILTER  
EFF FILTER  
NIGHT MODE  

AWB HEAD ZOOM REMOTE 
 FOCUS REMOTE 

DIGITAL EXT. DIASCOPE 
LENS FILE TEST PULSE 
AWB CH  
STEP GAIN  

* The gray items are adjusted by select type control. 
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4.2.2. VIDEO 
The controls arranged in the VIDEO page are as follows. 

Table. 4.2.2-1 

Page Control 

VIDEO 1 PED RED/GREEN/BLUE/MASTER 
FLARE OFF 
MATRIX OFF 
BLK GAMMA 

BLK SET RED/GREEN/BLUE 
GAIN WOBBLE 

FLARE RED/GREEN/BLUE/MASTER 

GAMMA  RED/GREEN/BLUE/MASTER 

BLK GAMMA  RED/GREEN/BLUE/MASTER 

STEP GAMMA GAMMA MODE 
STEP GAMMA 
GAMMA OFF 

GAIN RED/GREEN/BLUE/MASTER 
W.CLIP OFF 
KNEE OFF 
DTL OFF 

AWB CH AWB CH 
AWB HEAD 

CSTM GAMMA WIDTH/POINT/LEVEL 
ZEBRA IND 
DEFAULT CLEAR 

SHUTTER SUPER V 
SHUTTER MODE 
SHUTTER SPEED 

VIDEO 2 BLK SHADE R H SAW/H PARA/V SAW/V PARA 
MATRIX OFF 
B.SHADE OFF 
W.SHADE OFF 

BLK SHADE G H SAW/H PARA/V SAW/V PARA 

BLK SHADE B H SAW/H PARA/V SAW/V PARA 

WHT SHADE R H SAW/H PARA/V SAW/V PARA 
W.CLIP OFF 
KNEE OFF 

WHT SHADE G H SAW/H PARA/V SAW/V PARA 

WHT SHADE B H SAW/H PARA/V SAW/V PARA 

WHT CLIP RED/GREEN/BLUE 
AUTO KNEE OFF 

KNEE POINT RED/GREEN/BLUE/TOTAL 

KNEE SLOPE RED/GREEN/BLUE/TOTAL 

KNEE OTHERS SMOOTH KNEE 
SUPER KNEE 

* The gray items are adjusted by select/analog type control. 
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Table. 4.2.2-2 

Page Control 

SML VIDEO SML PED MASTER 
FLARE OFF 
MATRIX OFF 
BLK GAMMA 

SML GAMMA MASTER 

SML STEP GAMMA SML GAMMA MODE 
SML STEP GAMMA 
SML GAMMA OFF 

SML GAIN MASTER 
W.CLIP OFF 
SML KNEE OFF 
DTL OFF 

SML WHT CLIP RED/GREEN/BLUE 
AUTO KNEE OFF 

SML KNEE POINT TOTAL 

SML KNEE SLOPE TOTAL 

SML KNEE OTHERS SML SMOOTH KNEE 

* The gray items are adjusted by select/analog type control. 
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4.2.3. DTL 
The controls arranged in the DTL page are as follows. 

Table. 4.2.3-1 

Page Control 

DTL DTL1 GAIN/FREQ./B-W/BALANCE 
SLIM DTL 
DTL OFF 

DTL2 THRESH/FINE/NOISE SUP./Z. TRACK GAIN 
Z.TRACK DTL 

SOFT DTL WHT SUP./BLK SUP. 
SOFT DTL 

SKIN DTL GAIN GAIN/R HUE/B HUE/Z. TRACK GAIN 
Z. TRACK SKIN 
ZEBRA IND 
SKIN DTL 

SKIN HUE HUE MARKER 
AHD START 

COLOR DTL 
OBJECT CLIP 

SIZE/H POS/V POS. 
HUE MARKER 
AHD START 
COLOR DTL 

COLOR DTL 
CLIP ADJ. 

PHASE/FINE/WIDTH1/WIDTH2 
KEY INV. 
ZEBRA IND 

COLOR DTL LEVEL GAIN 

HI-LIGHT DTL GAIN/LIMIT 
HI-LIGHT DTL 

* The gray items are adjusted by select/analog type control. 
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Table. 4.2.3-2 

Page Control 

SML DTL SML DTL1 GAIN/FREQ./B-W/BALANCE 
SML DIAGONAL DTL 
DTL OFF 

SML DTL2 THRESH/FINE/NOISE SUP./Z. TRACK GAIN 
Z.TRACK DTL 

SML SOFT DTL WHT SUP./BLK SUP. 
SOFT DTL 

SML SKIN DTL GAIN GAIN/R HUE/B HUE/Z. TRACK GAIN 
Z. TRACK SKIN 
ZEBRA IND 
SKIN DTL 

SML SKIN HUE HUE MARKER 
AHD START 

SML COLOR DTL 
OBJECT CLIP 

SIZE/H POS/V POS. 
HUE MARKER 
AHD START 
COLOR DTL 

SML COLOR DTL 
CLIP ADJ. 

PHASE/FINE/WIDTH1/WIDTH2 
KEY INV. 
ZEBRA IND 

SML COLOR DTL 
LEVEL 

GAIN 

SML HI-LIGHT DTL GAIN/LIMIT 
HI-LIGHT DTL 

* The gray items are adjusted by select/analog type control. 
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4.2.4. COLOR 
The controls arranged in the COLOR page are as follows. 

Table. 4.2.4-1 

Page Control 

COLOR MATRIX R R-G/R-B 
MATRIX SELECT 
MATRIX OFF 

MATRIX G G-R/G-B 

MATRIX B B-R/B-G 

COLOR SAT. COLOR SAT. 
CHROMA OFF 
COLOR SAT. 

COLOR TEMP GAIN RED/VAR. C.TEMP/GAIN MASTER/GAIN 
BLUE 
ATW 

C.TEMP 5600K 

VAR C.TEMP 

COLOR HUE COLOR HUE 
COLOR HUE 

LOW SAT. THRESH/SAT. 
LOW SAT. 

CSTM COLOR CSTM COLOR 1 
OBJECT CLIP 

SIZE/H POS./V POS. 
HUE MARKER 
AHD START 
CSTM COLOR 1 

CSTM COLOR 1 
CLIP ADJ. 

PHASE/FINE/WIDTH1/WIDTH2 
KEY INV. 
ZEBRA IND 

CSTM COLOR 1 
COLOR 

HUE/SAT./VALUE/DTL 
DTL OFF 

CSTM COLOR 2 
OBJECT CLIP 

SIZE/H POS./V POS. 
HUE MARKER 
AHD START 
CSTM COLOR 2 

CSTM COLOR 2 
CLIP ADJ. 

PHASE/FINE/WIDTH1/WIDTH2 
KEY INV. 
ZEBRA IND 

CSTM COLOR 2 
COLOR 

HUE/SAT./VALUE/DTL 

* The gray items are adjusted by select/analog type control. 
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Table. 4.2.4-2 

Page Control 

COLOR 
CORR. 6 

 6 AXIS SET 
6 AXIS CLEAR 
COLOR CORR. 

(AXIS NO.1) HUE/SAT 

(AXIS NO.2) HUE/SAT 

(AXIS NO.3) HUE/SAT 

(AXIS NO.4) HUE/SAT 

(AXIS NO.5) HUE/SAT 

(AXIS NO.6) HUE/SAT 

COLOR 
CORR. 16 

 16 AXIS SET 
16 AXIS CLEAR 
COLOR CORR. 

(AXIS NO.1) HUE/SAT/VALUE 

(AXIS NO.2) HUE/SAT/VALUE 

(AXIS NO.3) HUE/SAT/VALUE 

(AXIS NO.4) HUE/SAT/VALUE 

(AXIS NO.5) HUE/SAT/VALUE 

(AXIS NO.6) HUE/SAT/VALUE 

(AXIS NO.7) HUE/SAT/VALUE 

(AXIS NO.8) HUE/SAT/VALUE 

(AXIS NO.9) HUE/SAT/VALUE 

(AXIS NO.10) HUE/SAT/VALUE 

(AXIS NO.11) HUE/SAT/VALUE 

(AXIS NO.12) HUE/SAT/VALUE 

(AXIS NO.13) HUE/SAT/VALUE 

(AXIS NO.14) HUE/SAT/VALUE 

(AXIS NO.15) HUE/SAT/VALUE 

(AXIS NO.16) HUE/SAT/VALUE 

* The gray items are adjusted by select/analog type control. 
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Table. 4.2.4-3 

Page Control 

SML COLOR SML MATRIX R R-G/R-B 
MATRIX SELECT 
MATRIX OFF 

SML MATRIX G G-R/G-B 

SML MATRIX B B-R/B-G 

SML COLOR SAT. COLOR SAT. 
CHROMA OFF 
COLOR SAT. 

SML COLOR HUE COLOR HUE 
COLOR HUE 

SML LOW SAT. THRESH/SAT. 
LOW SAT. 

SML CSTM 
COLOR 

SML CSTM COLOR 1 
OBJECT CLIP 

SIZE/H POS./V POS. 
HUE MARKER 
AHD START 
CSTM COLOR 1 

SML CSTM COLOR 1 
CLIP ADJ. 

PHASE/FINE/WIDTH1/WIDTH2 
KEY INV. 
ZEBRA IND 

SML CSTM COLOR 1 
COLOR 

HUE/SAT./VALUE/DTL 
DTL OFF 

SML CSTM COLOR 2 
OBJECT CLIP 

SIZE/H POS./V POS. 
HUE MARKER 
AHD START 
CSTM COLOR 2 

SML CSTM COLOR 2 
CLIP ADJ. 

PHASE/FINE/WIDTH1/WIDTH2 
KEY INV. 
ZEBRA IND 

SML CSTM COLOR 2 
COLOR 

HUE/SAT./VALUE/DTL 

* The gray items are adjusted by select/analog type control. 
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Table. 4.2.4-4 

Page Control 

SML COLOR 
CORR. 16 

 16 AXIS SET 
16 AXIS CLEAR 
COLOR CORR. 

(AXIS NO.1) HUE/SAT/VALUE 

(AXIS NO.2) HUE/SAT/VALUE 

(AXIS NO.3) HUE/SAT/VALUE 

(AXIS NO.4) HUE/SAT/VALUE 

(AXIS NO.5) HUE/SAT/VALUE 

(AXIS NO.6) HUE/SAT/VALUE 

(AXIS NO.7) HUE/SAT/VALUE 

(AXIS NO.8) HUE/SAT/VALUE 

(AXIS NO.9) HUE/SAT/VALUE 

(AXIS NO.10) HUE/SAT/VALUE 

(AXIS NO.11) HUE/SAT/VALUE 

(AXIS NO.12) HUE/SAT/VALUE 

(AXIS NO.13) HUE/SAT/VALUE 

(AXIS NO.14) HUE/SAT/VALUE 

(AXIS NO.15) HUE/SAT/VALUE 

(AXIS NO.16) HUE/SAT/VALUE 

* The gray items are adjusted by select/analog type control. 
  



ETC. 

27 

4.2.5. ETC. 
The controls arranged in the ETC. page are as follows. 

Table. 4.2.5-1 

Page Control 

SYSTEM GL PHASE SC COARSE/SC FINE/SML H PHASE/H PHASE 

ENC GAIN/CHROMA 

ASPECT RATIO MODE SELECT 

HD CUTOUT (AREA)/X/Y 
MEMORY1 
MEMORY2 
MEMORY3 
STORE 

LENS AUTO IRIS PEAK RATIO/LEVEL 
IRIS SET MODE 

ZOOM FOCUS ZOOM/FOCUS 
ZOOM REMOTE 
FOCUS REMOTE 

TRIAX SD TRIAX TA LEVEL Y/CB/CR 
HEAD BARS 

SD TRIAX BS LEVEL RED/GREEN/BLUE 

SD TRIAX BS BLK 
LEVEL 

RED/GREEN/BLUE 

HD TRIAX TA LEVEL Y/PB/PR 

HD TRIAX TA BLACK Y/PB/PR 

OTHERS DGTL EXT. DIGITAL EXT. 

AVC NIGHT MODE 
AVC 
FILTER HOLD 

MIC GAIN MIC1 FINE/MIC1 STEP/MIC2 FINE/MIC2 STEP 

* The gray items are adjusted by select/analog type control. 
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4.3. Setup category 

4.3.1. STANDARD 
On the STANDARD page, there is two functions. 
Preset File Load is a function to read a Preset File saved in advance, and it is 
done separately for the camera head and the CCU. 
 
Note: 
Factory Data is factory set value and can not be rewritten by the user. 
 
Manual File is a function to set and restore all analog adjustment values of the 
camera. 

 
 

 
Figure. 4.3.1-1 

Table. 4.3.1-1 

Preset File Load Head Engineer1 / Factory 
 BS/CCU Engineer1~3 / Factory 

Manual File All Set - 
 All Clear - 

 
Select the process you want to execute and press the EXECUTE button to 
execute the process. 
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4.3.2. FILE 
On the FILE page, you can send and receive camera files, and manage the 
saved files. 
 
(1) TRANSFER 

When sending a file to the camera, first select FILE TYPE. Next, select the 
file to be sent from FILE LIST and press the SEND button. If the MODEL 
does not match, an error is output. 
When receiving a file from the camera, select FILE TYPE and press the 
RECV button. The file name is generated automatically. 
 
CAUTION: 
Depending on the file, transfer may take more than one minute. 
 

 
Figure. 4.3.2-1 

(2) MANAGEMENT 
In the EDIT operation, edit the file name and comment of the selected 
file. In the DELETE operation, deletes the selected file. 
In the EXPORT operation, copies the selected file to external media. You 
can save it to SD card and transfer files from OCP-300 or MCP-300. 
In the IMPORT operation, copies files from external media. Files saved on 
an SD card can be managed all at once with VMP. 
 
CAUTION: 
When handling the exported file with OCP-300 or MCP-300, please match 
the rules of file system and file name on the device side. 
 

 
Figure. 4.3.2-2 
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4.3.3. AUTO SETUP 
On the AUTO SETUP page, execute Auto Setup and Reference Setup. 
For details of each Setup, please refer to the operation manual of camera 
head. 
 

Table. 4.3.3-1 

AUTO AWB 
ABB 
FULL 
FULL LEVEL 
LEVEL 
FULL QUICK 
QUICK 
BLACK SHADE 

REFERENCE Level Reference 
ABB Reference 
AWB Reference 

 
 

 
Figure. 4.3.3-1 

 
Figure. 4.3.3-2 
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4.3.4. FORMAT 
On the FORMAT page, change the system format of the camera. Select the 
format from the drop down list and press Execute. 
 
CAUTION: 
Because the camera head restarts, camera selection can not be performed 
temporarily. 
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 Monitoring Cameras 
The Monitor Category monitors the status of all cameras in the selected group. 

 

5.1. Device 
On the Device page, a list of all devices recognized by VMP is displayed. 
 
Note: 
Gateway is a communication application. VMP also treats it as one device. 

 

 
Figure. 5.1-1 

 

5.2. Camera Status 
On the Camera Status page, the status of all cameras in the selected group is 
listed. Items not supported by the camera are blank. It is also possible to 
change the setting by clicking on the cell directly. For items that are different 
from the standard state, the cell is highlighted. The standard state can be 
changed in Configurations. 
 
PARA COPY button can only be used in multi mode. Copy the state of the master 
camera to all slave cameras. 

 

 
Figure. 5.2-1 
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5.3. Diagnostics 
On the Diagnostics page, the diagnostic information of all cameras in the 
selected group is listed. Cells are highlighted for items with alarms. 

 

 
Figure. 5.3-1 

 

5.4. Optical Level 
On the Optical Level page, the optical level of all cameras in the selected group 
is displayed graphically. 
 

 

 
Figure. 5.4-1 
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 Panel Assignment 
Panel Assignment is a function to change the combination of control panel (OCP) 
and camera (CCU) connection remotely. 
When you change the category to “TOOL”, the matrix of vertical axis OCP and 
horizontal axis CCU is displayed. 
Assignment can be switched by selecting (clicking) the intersection of the matrix. 
Regardless of the group setting, all the OCPs and CCUs recognized at that time 
are displayed in the matrix. 
 

 
Figure. 6-1 

 

6.1. Change Assignment 
You can change the assignment by selecting (clicking) the intersection of OCP 
and CCU. 
When you press and hold an intersection, it sets the OCP assignment to "no 
assignment". 

 

6.2. Lock 
In order to prevent erroneous operation, locking of the assignment operation 
can be set for each OCP. 
Clicking the key mark ( ) locks the OCP assignment operation. Click again to 
unlock it. 
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6.3. Memory 
Up to four assignment patterns can be saved. 
The assignment pattern is saved as Group/Device ID, not IP addresses. 
 
(1) Load from memory 
When “LOAD” is selected and the memory button is pressed, the saved 
assignment pattern is reproduced. If an OCP or CCU that existed at the time of 
saving does not exist, it is ignored. 
 
(2) Store to memory 
When “STORE” is selected and the memory button is pressed, the assignment 
pattern at that time is saved. Locked state is not saved. 

 

6.4. Behavior at overlapping 
You can specify the behavior when the CCU of the assignment destination is 
overlapped. (Configurations > Tools > Panel Assignment) 
 
(1) Confirmation Dialog 
Sets whether or not to confirm if overlap occurs. 
 
(2) Overlap Action 
 
Single Overlapping is not allowed. If it is overlapped, the assignment 

operation will be ignored. 

Parallel Overlapping is allowed. 

Swap Overlapping is not allowed. If it is overlapped, the CCU of the 
assignment will be exchanged. 

No Assignment Overlapping is not allowed. If it is overlapped, that OCP will be 
set to "No Assignment". 
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 Control Depth 
Control Depth is a function to restrict the controllable range of the VMP operator 
in four levels. 
To change the restriction level, you need to enter a password (4 digit number). 
 
Restriction Level 

Basic Restricted basic items and monitoring 
Standard Basic plus some functions for camera operation 
Extended All basic camera operation items 
Complete No restriction 

 

7.1. Restricted items 
 

Restricted Items (Menu) 

Function / Page B S E C 
Menu File Import License...    ✔ 

Quit ✔ ✔ ✔ ✔ 
Setting Scaling ✔ ✔ ✔ ✔ 

Control Depth ✔ ✔ ✔ ✔ 
Configurations...    ✔ 

Help Manual ✔ ✔ ✔ ✔ 
License ✔ ✔ ✔ ✔ 
About ✔ ✔ ✔ ✔ 

B=Basic, S=Standard, E=Extended, C=Complete 
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Restricted Items (Page) 
Function / Page B S E C 

Common Control Menu *    ✔ 

Items except Menu * ✔ ✔ ✔ ✔ 

Control ON/OFF *   ✔ ✔ 

VIDEO VIDEO 1 *   ✔ ✔ 

VIDEO 2 *   ✔ ✔ 

SML VIDEO *   ✔ ✔ 

DTL DTL *   ✔ ✔ 

SML DTL *   ✔ ✔ 

COLOR COLOR *   ✔ ✔ 

CSTM COLOR *   ✔ ✔ 

COLOR CORR. 6 *   ✔ ✔ 

COLOR CORR. 16 *   ✔ ✔ 

SML COLOR *   ✔ ✔ 

SML CSTM COLOR *   ✔ ✔ 

SML COLOR CORR. 16 *   ✔ ✔ 

ETC. SYSTEM    ✔ 

LENS    ✔ 

TRIAX    ✔ 

OTHERS    ✔ 

USER USER1~4 *    ✔ 

Setup STANDARD *    ✔ 

FILE TRANSFER *   ✔ ✔ 

MANAGEMENT *    ✔ 

AUTO SETUP AUTO *  ✔ ✔ ✔ 

REFERENCE    ✔ 

FORMAT *    ✔ 

Monitor DEVICE ✔ ✔ ✔ ✔ 

CAMERA STATUS ✔ ✔ ✔ ✔ 

DIAGNOSTIC ✔ ✔ ✔ ✔ 

OPTICAL LEVEL ✔ ✔ ✔ ✔ 

Tool PANEL ASSIGNMENT *   ✔ ✔ 

Manual Clear *  ✔ ✔ ✔ 

Manual Set *   ✔ ✔ 

Multi Control ✔ ✔ ✔ ✔ 

B=Basic, S=Standard, E=Extended, C=Complete 
* Customizable at (Configurations > General > Control Depth) 
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7.2. Changing restriction level 
To change the restriction level of Control Depth, select level from (Setting > 
Control Depth) on the Menu bar and enter the password. 
 

 
Figure. 7.2-1 

 

7.3. Changing password 
The initial password is "0000". 
When using the Control Depth function, please change it with Configurations. 
(Configurations > General > Control Depth > Change Password) 
 

 
Figure. 7.3-1 

 

7.4. How to initialize password 
If you have forgotten your password, please initialize your password by installer. 
Launch installer and select "Initialize Password". 
 

 
Figure. 7.4-1 
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 Customize 
VMP can customize some control items according to the user's operating 
discipline. 

 

8.1. Home 
Home launcher can be customized in Configurations. 
(Configurations > Customize > Home) 
 

 
Figure. 8.1-1 

Please set each function without a gap. Also, it is not possible to set two or 
more same Functions. 
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8.2. User 
You can customize USER 1 to 4 pages of the Control category. 
(Configurations > Customize > Control) 
In addition, you can set the name displayed in the page section of the Control 
category. (Up to 8 characters) 
 

 
Figure. 8.2-1 

 

8.3. Standard Function 
The standard setting of Camera Status displayed in the Monitor category can 
be changed. (Configurations > General > Standard Function) 
Items different from the standard setting are highlighted. 
 

 
Figure. 8.3-1 
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8.4. Control Depth 
You can customize the restriction level of the Control Depth for each item. 
(Configurations > General > Control Depth) 
You can also change password here. 
 

 
Figure. 8.4-1 
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 Configurations 
 

Table. 9-1 

Category / Item Description 
General 
 Protocol Gateway  

 IP Address Default: 127.0.0.1 *1 
Port No (Control) Default: 55100 *1 
Port No (Data) Default: 55110 *1 

Control Depth See Section 7.1 for details 
 Change Password See Section 7.3 for details 
Standard Function  
Analog Control  
 Control Type Analog Control Type (Slider, Rotate) 

Range Analog Control Range (1/4, 1/2, STD, x2, x4) 
Assignment 
 Camera See Section 3.1 for details 

Group See Section 3.1 for details 
Control 
 Control  

 Tally Guard Off, Limit, All (See Section 4.1.4 for details) 
Hi Gain Send Items of +60 dB or more of Step Gain 
Multi Select Keep Keep parallel selection or not 

Display  
 M.PED Value %data, CONT 

W.CLIP Value %data, CONT 
Call Latch On, Off 
Disp Limit On, Off 

Customize 
 Home See Section 8.1 for details 

Control See Section 8.2 for details 
Tools 
 Panel Assignment  

 Confirmation Dialog On, Off 

Overlap Action Single, Parallel, Swap, No Assign 

*1 It is an item to change when using in a special environment. Normally must not change. 
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 License Options 
All functional categories and pages in VMP are provided as licensing options with 
charge. 
To issue licenses, you need the MAC address of the PC on which the application 
is installed. (Wired LAN only) 
Please contact us for details. 

 

Table. 10-1 

License Option Function category / page 
Camera Control Control category 
Multi Control Multi control function (Camera Control license is required) 
Standard Function Setup category (Standard) 
File Operation Setup category (File) 
Auto Setup Setup category (Auto Setup) 
System Format Setup category (Format) 
Status Monitor Monitor category 
Panel Assignment Tool category 

 

10.1. How to import license 
(1) Select (File> Import License ...) from Menu. 

 

 
Figure. 10.1-1 

(2) Select the license file from the dialog box. 
(3) Select OK when the dialog box prompts to restart the application. 

 

10.2. Confirm valid license 
You can check the status of license options from the Menu. 
(Help > License) 
 

Table. 10.2-1 

Expiration Date Description 
YYYY/MM/DD The license is valid with the expiration date. 
Purchased The license is valid indefinitely. 
Not Purchased The license is invalid. 
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 Frequently Asked Questions 
 
Q1.  

Device is not recognized. 
A1. 

Please check whether the Group ID, Device ID, Master setting of each device is 
correct. Also check the connection with the communication application. 

 
Q2. 

Camera function is disabled. 
A2. 

All of the following conditions must be satisfied for the function to be effective. 
 Camera supports that function 
 License option is valid 
 Control Depth is not restricted 
Please check whether all of the above conditions are satisfied. 

 
Q3. 

Can not display and change OCP assignment destination in Panel Assignment. 
A3. 

If OCP Mode is set to other than Normal Mode, OCP assignment can not be 
controlled remotely. Please set OCP Mode to "NOR" from Panel Config of OCP. 

 
Q4. 

In the ON / OFF control, it does not change to the selected item. 
A4. 

In an VMP, all items are displayed for control selected from multiple items such 
as Step Gain and Preset Shutter. 
If it does not change to that value even if you select it, please check whether 
the camera supports that function. 

 
Q5. 

Characters are small and difficult to read. 
A5. 

By changing the scaling it is possible to display the entire UI including 
characters in large size. However, the display range becomes narrower by that 
much. 
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 Specifications 
 

12.1. System Requirements 
 

Table. 12.1-1 

Operating System Microsoft Windows® 7 Professional SP1 (64bit/32bit) 
Microsoft Windows® 10 Professional (64bit/32bit) 

Runtime .NET Framework 4.6.2 

Processor 1 GHz or faster 32-bit (x86) or 64-bit (x64) processor 

Memory 1 GB RAM (32-bit) or 2 GB RAM (64-bit) 

Storage 16 GB available disk space (32-bit) or 20 GB (64-bit) 

Graphics DirectX9 graphics device with WDDM 1.0 or higher driver 

Network 100Mbps or faster ethernet adapter (wired only) 

Resolution 1366x768 or 1920x1080 (recommended) 

 
 

12.2. Enabled Devices 
VMP supports the camera heads of the Unicam HD series or later and the 
devices that can be directly connected to the network as follows. 
Depending on the time of sale, it may be necessary to update the firmware of 
these devices. Please contact us for details. 

 

Table. 12.2-1 

Camera Head UHK-430, HDK-97A, HDK-99, HDK-55, HDK-79GX, HDK-73 
(Unicam HD series or later) 

CCU / BS CCU-430, CCU-980, BS-98 

Control Panel MCP-300, OCP-300 

* As of August 2018 
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 Changing Information 
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